
Picasa Basics for the Web 
Overview 

Picasa for Windows is a free image editing software 
program from Google. It can be used with images from 
digital cameras, scans, off the web, or even images 
created in a paint program. Features include a library 
for browsing images on the computer, image 
enhancement tools, and image sharing tools. This 
tutorial will introduce you to Picasa, with a focus on 
preparing images to use on the Web. 

Topic 1: Picasa Installation 
This module will review the basics for obtaining Picasa 
and installing it. 

Subtopic 1: Where to get Picasa 
Subtopic 2: Installation issues 
Assessment: Interface 

Topic 2: Picasa Interface 
This module will review the basic interface elements 
and tools of Picasa. 

Subtopic 1: Library Browser 
Subtopic 2: Tools 
Subtopic 3: Export/save options 
Assessment: Image Editing 

Topic 3: Images for the Web 
This module includes information on planning for using 
images on web pages. 

Subtopic 1: Type of image 
Subtopic 2: Size of image 
Assessment: Image Size 

Topic 4: Extras 
The following are additional resources for working 
with images on the Web. 
 
Picasa Help and FAQ 
http://picasa.google.com/support/  
 
Working with images on the web. 
http://depts.washington.edu/trio/train/howto/pieces/ima
ges/index.shtml 
 
Clip art for Teachers 
http://www.clipartforteachers.com/  
 
ClipArt.com 
http://www.clipart.com  
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Picasa Basics for the Web 

Overview 

Picasa for Windows is a free image editing software program from Google. It can be 
used with images from digital cameras, scans, off the web, or even images created in a 
paint program. Features include a library for browsing images on the computer, image 
enhancement tools, and image sharing tools. This tutorial will introduce you to Picasa, 
with a focus on preparing images to use on the Web. 

Topic 1: Picasa Installation 

This module will review the basics for obtaining Picasa and installing it. 

Subtopic 1: Where to get Picasa 

Obj:  

To find Picasa on the Internet 

Content:  

Picasa can be found at www.picasa.google.com. The Picasa home page describes 
many of the programs features, system requirements, and includes a link to 
download the program. 

Learning Activity: Download Picasa 

Go to the Picasa home page ( www.picasa.google.com ) and download the free 
Picasa software. Don’t install it yet. That is part of the next sub-topic. 

Subtopic 2: Installation issues 

Obj:  

To install Picasa on a computer 

Content: 

The Picasa installation Wizard will guide you through the basic installation. 
There are two items to keep in mind with first installing Picasa. 
 
1. If you have a previous version of Picasa and it has already set-up a library of 
your images, install the new version before you uninstall the old version. After the 
new version is installed, start it. You will be asked if you want to import your 
existing library database. Select yes if you do. Once your new version of Picasa 
has imported your library, you can uninstall the old version. 
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2. When you first install Picasa it will ask you if you want it to scan your 
computer for images and create a library for you. Be careful here. Unless you 
give it some limits, Picasa will add every image on your hard drive to the library. 
It doesn’t move the images but it does list the folders they are in. You have more 
images on your computer than you realize. I recommend you restrict the search to 
your “My Pictures” folder or your “My Documents” folder. 

Learning Activity:  

Install Picasa on your computer. Remember to pay attention to how Picasa is set 
to scan your computer for images. 

Assessment: Interface 

Complete a reflection activity on the Picasa installation. Were there any 
problems? What would you do differently when installing on another 
computer?  

Topic 2: Picasa Interface 

This module will review the basic interface elements and tools of Picasa. 

Subtopic 1: Library Browser 

Obj:  

To locate images on a computer 

Content: 

The Library view includes three sections; the folder list, the picture tray, and the 
light box. Let’s look at each section. 
 
The folder list includes all the folders containing images that Picasa scanned 
during installation. They are sorted by date of creation. Clicking on a folder 
displays those images in the light box. You can make changes in the Folder 
Manager under the Tools menu. 
 
The picture tray is where you collect images to work on as a collection or group. 
When you select a picture in the light box it is put in the picture tray. You add 
pictures to the tray by pressing the Hold button and selecting more pictures, or by 
dragging and dropping. Options include Print, Email, Collage, Hello, Blogger, 
Order, and Export. 
 
The light tray displays all the images in the currently selected folder from the 
folder list. You can use the View menu to change the thumbnail size, or use the 
slider, bottom right of the light box. Double clicking on a thumbnail will open it 
up in the light box. That image is now ready for editing. 
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Go to the Picasa Library Overview 
(http://picasa.google.com/help/userguide_organize.html ) for more information 
on how to use the Library. Use the Back button in your browser to return here. 
 
Note: Add graphic “picasaMain.jpg”. 

Learning Activity: View Images 

1. Select a folder in the folder list and practice changing the thumbnail view 
size. 

2. Add more than one image to the picture tray. 

Subtopic 2: Tools 

Obj:  

To locate and recognize Picasa tools 

Content: 

The Picasa tools are very user friendly. Double click on a thumbnail of an image 
to open that image in the light box and the image editing tools. All the changes 
you make to an image in Picasa do not change the original file. You must export 
an image from Picasa to keep the changes. There are three tool categories: Basic 
Fixes, Tuning, and Effects. 
 
Go to the Picasa Editing Overview 
(http://picasa.google.com/help/userguide_edit.html ) for more information on 
each of the Picasa tools. Use the Back button in your browser to return here. 
 
Note: Add graphic “picasaedit.jpg”. 

Learning Activity: Edit an Image 

1. Select an image on your computer. Go to the Basic Fixes tools and use the 
crop tool to cut out parts of the picture. 

2. Go to the Tuning tools and adjust the highlights and shadows. 

3. Go to the Effects tools and explore some of the different effects. 

Subtopic 3: Export/save options 

Obj:  

To export images out of Picasa 
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Content: 

The Picture Tray control includes buttons for sharing images in a variety of ways. 
You can print images, email them, create collages, upload to blogs, and export 
images. Picasa never changes your original image files so you have to export you 
images in some manner to save the changes. When you export an image you will 
be asked for a folder name to place the image in. Picasa saves the image with the 
original file name. You can choose to change the size of the image before you 
save it. 
 
Note: Add graphic “PicasaExportScreen.jpg”. 

Learning Activity: Export an Image 

Select a thumbnail image and make sure it appears in the Picture Tray. Then click 
Export and save the image on your computer. 

Assessment: Image Editing 

Using the following answer options: 

A. Basic Fixes 
B. Tuning 
C. Effects 

Answer these questions: 

Where is the "Highlights Slider?" 

Where is the "I'm Feeling Lucky" tool? 

Where is the "Film Grain" tool? 

Topic 3: Images for the Web 

This module includes information on planning for using images on web pages. 

Subtopic 1: Type of image 

Obj:  

To select an appropriate image format for the web 

Content: 

There are several standard image file formats used on the Internet; including jpeg, 
gif, and png. Of these formats jpeg is probably the most common. If you are 
planning on using an image on a web site, exporting and saving that image as a 
jpeg file is recommended. Picasa makes this easy in that it automatically saves 
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images as jpegs. You can use a slider to change the image quality of the jpeg. 
Usually a setting of 45% to 50% works well. 

Learning Activity: Adjust JPEG Quality 

Select an image and export it. Adjust the image quality to 45%, then save the 
image. 

Subtopic 2: Size of image 

Obj:  

To save an image in a appropriate size for the web 

Content: 

Computer screens consist of many very small pixels of light. In general, screens 
range from 72 to 96 pixels an inch. If you want an image to appear to be about 
two inches across on your screen, then change the image size to 144 dpi wide 
when you export it. Most screens are set to be either 800 pixels wide, or 1024 
pixels wide, so plan your images accordingly. For example, if an image should 
take up half the screen width, go with 400 or 512 dpi wide. 

Learning Activity: Change Image Size 

Export an image from Picasa, with the size of the width set to take up ¼ of the 
computer screen. Practice different size adjustments and note the amount of space 
the image takes up on a screen. 

Assessment: Image Size 

Answer the following questions. 
 
1. Approximately what width should an image be to take up 1/3 of a screen set at 
800 pixels wide? 
2. Approximately what width should an image be to appear about 1 and ½ inches 
wide on a typical computer screen? 

Topic 4: Extras 

The following are additional resources for working with images on the Web. 
 
Picasa Help and FAQ 
http://picasa.google.com/support/  
 
Working with images on the web. 
http://depts.washington.edu/trio/train/howto/pieces/images/index.shtml 
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Clip art for Teachers 
http://www.clipartforteachers.com/  
 
ClipArt.com 
http://www.clipart.com  
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	Picasa Basics for the Web
	Overview
	Picasa for Windows is a free image editing software program from Google. It can be used with images from digital cameras, scans, off the web, or even images created in a paint program. Features include a library for browsing images on the computer, image enhancement tools, and image sharing tools. This tutorial will introduce you to Picasa, with a focus on preparing images to use on the Web.

	Topic 1: Picasa Installation
	This module will review the basics for obtaining Picasa and installing it.
	Subtopic 1: Where to get Picasa
	Obj: 
	To find Picasa on the Internet

	Content: 
	Picasa can be found at www.picasa.google.com. The Picasa home page describes many of the programs features, system requirements, and includes a link to download the program.

	Learning Activity: Download Picasa
	Go to the Picasa home page ( www.picasa.google.com ) and download the free Picasa software. Don’t install it yet. That is part of the next sub-topic.


	Subtopic 2: Installation issues
	Obj: 
	To install Picasa on a computer

	Content:
	The Picasa installation Wizard will guide you through the basic installation. There are two items to keep in mind with first installing Picasa.  1. If you have a previous version of Picasa and it has already set-up a library of your images, install the new version before you uninstall the old version. After the new version is installed, start it. You will be asked if you want to import your existing library database. Select yes if you do. Once your new version of Picasa has imported your library, you can uninstall the old version.  2. When you first install Picasa it will ask you if you want it to scan your computer for images and create a library for you. Be careful here. Unless you give it some limits, Picasa will add every image on your hard drive to the library. It doesn’t move the images but it does list the folders they are in. You have more images on your computer than you realize. I recommend you restrict the search to your “My Pictures” folder or your “My Documents” folder.

	Learning Activity: 
	Install Picasa on your computer. Remember to pay attention to how Picasa is set to scan your computer for images.


	Assessment: Interface
	Complete a reflection activity on the Picasa installation. Were there any problems? What would you do differently when installing on another computer? 


	Topic 2: Picasa Interface
	This module will review the basic interface elements and tools of Picasa.
	Subtopic 1: Library Browser
	Obj: 
	To locate images on a computer

	Content:
	The Library view includes three sections; the folder list, the picture tray, and the light box. Let’s look at each section.  The folder list includes all the folders containing images that Picasa scanned during installation. They are sorted by date of creation. Clicking on a folder displays those images in the light box. You can make changes in the Folder Manager under the Tools menu.  The picture tray is where you collect images to work on as a collection or group. When you select a picture in the light box it is put in the picture tray. You add pictures to the tray by pressing the Hold button and selecting more pictures, or by dragging and dropping. Options include Print, Email, Collage, Hello, Blogger, Order, and Export.  The light tray displays all the images in the currently selected folder from the folder list. You can use the View menu to change the thumbnail size, or use the slider, bottom right of the light box. Double clicking on a thumbnail will open it up in the light box. That image is now ready for editing.  Go to the Picasa Library Overview (http://picasa.google.com/help/userguide_organize.html ) for more information on how to use the Library. Use the Back button in your browser to return here.  Note: Add graphic “picasaMain.jpg”.

	Learning Activity: View Images
	1. Select a folder in the folder list and practice changing the thumbnail view size.
	2. Add more than one image to the picture tray.


	Subtopic 2: Tools
	Obj: 
	To locate and recognize Picasa tools

	Content:
	The Picasa tools are very user friendly. Double click on a thumbnail of an image to open that image in the light box and the image editing tools. All the changes you make to an image in Picasa do not change the original file. You must export an image from Picasa to keep the changes. There are three tool categories: Basic Fixes, Tuning, and Effects.  Go to the Picasa Editing Overview (http://picasa.google.com/help/userguide_edit.html ) for more information on each of the Picasa tools. Use the Back button in your browser to return here.  Note: Add graphic “picasaedit.jpg”.

	Learning Activity: Edit an Image
	1. Select an image on your computer. Go to the Basic Fixes tools and use the crop tool to cut out parts of the picture.
	2. Go to the Tuning tools and adjust the highlights and shadows.
	3. Go to the Effects tools and explore some of the different effects.


	Subtopic 3: Export/save options
	Obj: 
	To export images out of Picasa

	Content:
	The Picture Tray control includes buttons for sharing images in a variety of ways. You can print images, email them, create collages, upload to blogs, and export images. Picasa never changes your original image files so you have to export you images in some manner to save the changes. When you export an image you will be asked for a folder name to place the image in. Picasa saves the image with the original file name. You can choose to change the size of the image before you save it.  Note: Add graphic “PicasaExportScreen.jpg”.

	Learning Activity: Export an Image
	Select a thumbnail image and make sure it appears in the Picture Tray. Then click Export and save the image on your computer.


	Assessment: Image Editing
	Using the following answer options:
	A. Basic Fixes B. Tuning C. Effects
	Answer these questions:
	Where is the "Highlights Slider?"
	Where is the "I'm Feeling Lucky" tool?
	Where is the "Film Grain" tool?




	Topic 3: Images for the Web
	This module includes information on planning for using images on web pages.
	Subtopic 1: Type of image
	Obj: 
	To select an appropriate image format for the web

	Content:
	There are several standard image file formats used on the Internet; including jpeg, gif, and png. Of these formats jpeg is probably the most common. If you are planning on using an image on a web site, exporting and saving that image as a jpeg file is recommended. Picasa makes this easy in that it automatically saves images as jpegs. You can use a slider to change the image quality of the jpeg. Usually a setting of 45% to 50% works well.

	Learning Activity: Adjust JPEG Quality
	Select an image and export it. Adjust the image quality to 45%, then save the image.


	Subtopic 2: Size of image
	Obj: 
	To save an image in a appropriate size for the web

	Content:
	Computer screens consist of many very small pixels of light. In general, screens range from 72 to 96 pixels an inch. If you want an image to appear to be about two inches across on your screen, then change the image size to 144 dpi wide when you export it. Most screens are set to be either 800 pixels wide, or 1024 pixels wide, so plan your images accordingly. For example, if an image should take up half the screen width, go with 400 or 512 dpi wide.

	Learning Activity: Change Image Size
	Export an image from Picasa, with the size of the width set to take up ¼ of the computer screen. Practice different size adjustments and note the amount of space the image takes up on a screen.


	Assessment: Image Size
	Answer the following questions.  1. Approximately what width should an image be to take up 1/3 of a screen set at 800 pixels wide? 2. Approximately what width should an image be to appear about 1 and ½ inches wide on a typical computer screen?


	Topic 4: Extras
	The following are additional resources for working with images on the Web.  Picasa Help and FAQ http://picasa.google.com/support/   Working with images on the web. http://depts.washington.edu/trio/train/howto/pieces/images/index.shtml  Clip art for Teachers http://www.clipartforteachers.com/   ClipArt.com http://www.clipart.com 



